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SpotBot® 3 Personal Microarrayer Software 
 

SPOCLE Generator v3.5.2 and SpotApp v3.6.0 Software 
 
I.  SPOCLE Generator v3.5.2 
 
• Two steps required to run SpotBot® 3: (1) creating a SPOCLE file and (2) executing the 

SPOCLE file using SpotApp. 
• Users begin by creating a printing routine using SPOCLE Generator. 
• Double-click on the SPOCLE Generator v3.5.2 desktop icon (shown here as highlighted) 

to launch the SPOCLE software. 
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• The Start menu allows users to select a Factory Default Profile (selected here) or a User 
Profile containing settings from a previous routine. 

• New users should select the Factory Default Profile as shown here and click Next in the 
bottom right corner of the dialog box to advance to the next window. 
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• The Pins menu allows users to select the Pin Type (type of pin loaded into the printhead) 
and the Pin Configuration (1, 2 or 4 pins in the printhead). 

• Please note that the pin locations in the printhead are illustrated in the Pin Configuration 
Legend located on the right side of the dialog box. 

• New users should select the 946MP4 Pin Type in a 2x2 Pin Configuration as shown here, 
and click Next to advance to the next window. 
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• The Plates menu allows users to select Full Microplates, a Partial Microplate or to import 
data from a specialized text file for custom sample loading (Import From Sample Pick 
File). 

• New users should select the Full Microplates option as shown here. 
• The Plates menu also allows users to enter the number of microplates to be printed. 
• New users should select a Total Microplate Count of 1 as shown here.  Please note that 

the software calculates the number of samples (in this case 384) based on the number 
of 384-well microplates selected by the user. 

• Users can also select from 1-5 Spots Per Sample for the number of successive technical 
replicates to be printed on each substrate slide with each loaded sample. 

• Triplicate printing, shown here in the Spots Per Sample dialog box, will deposit three 
spots for each sample on each glass substrate slide. Please note that the software 
calculates the Total number of spots (in this case 1152) to be printed on each substrate 
slide, based on 384 samples printed in triplicate (384 x 3 = 1152). 

• Click Next to advance to the next window. 
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• The Microarrays menu allows users to select the distance between printed spots on each 
glass substrate slide in microns (µm). 

• New users should select 175 µm as a convenient Spot Spacing. 
• The Microarrays menu also allows users to select the Subgrid Dimensions, which is the 

number of Columns and Rows in the printed microarray. 
• New users should select the desired number of rows and columns such as 24 x 25 as 

shown here. 
• The Print Offset allows users to define the distance in millimeters between the printed 

microarray and the upper left corner of each glass substrate slide. 
• New users should select a convenient Print Offset such as 8.0 Lateral and 10.0 Vertical 

as shown here, to position the printed microarray in the center of the substrate. 
• Please note that the graphic on the right side of the dialog box depicts the location of 

each printed microarray on Substrates 1-7 and Substrates 8-14. 
• To maximize printing speed and affordability and to minimize the instrument footprint, 

SpotBot® 3 permits printing on the entire surface of substrates 1-7 and on the top 40% 
of substrates 8-14 as shown in the graphic. 

• Click Next to advance to the next window. 
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• The Substrates menu allows users to define number and location of glass substrate 
slides to be printed in a given routine. 

• Users can double-click on each of the 14 printing locations to define print, preprint or 
unused for the 14 substrate locations. 

• New users should select the first substrate as the preprint substrate and substrates 2-14 
for printing as shown here. 

• The Substrates menu also allows users to define the number of preprint spots per 
sample. 

• New users should select 10 in the Pre-print Spots Per Sample as a convenient number of 
preprint spots. 

• Click Next to advance to the next window. 
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• The Motion menu allows users to select the length of extra time (“Dwell Times”) in 
seconds that the printing pins make contact with the surface of the microplates and 
glass substrate slides during the printing routine. 

• Increasing the Dwell Times may be required to load excessively viscous samples or to 
increase the amount of sample delivered and the spot size delivered by the printing pins. 

• New users should use the default settings of 3.0 seconds for Sample Loading, 0.0 
seconds for Pre-printing and 0.0 seconds for Printing as shown here. 

• Click Next to advance to the next window. 
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• The Wash/dry menu allows users to define the number and duration of each wash and 
dry step in the pin cleaning procedure. 

• The Wash/dry menu allows users to specify the parameters for the Wash/dry cycles used 
during the printing process. 

• The default parameters shown here provide efficient pin cleaning for most applications. 
• The default settings direct 4 Wash/Dry cycles during the print run and 10 Wash/Dry 

cycles at the end of the print run. 
• New users should use the instrument default settings shown here. 
• Click Next to advance to the next window. 
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• The Options menu allows users to enter a custom file name for each SPOCLE printing 
routine created. 

• The file name SpotBot3_Test_Print has been entered into the dialog box shown here. 
• Users are encouraged to enter a new name for each print routine and copy the SPOCLE 

Title for use in the next window. 
• Click Next to advance to the Next window. 
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• The Finish menu allows users to enter a file path for the printing routine. The file path 
saves the printing routine in a specific location on the C drive, desktop or other location. 

• Click on the right side of the SPOCLE Microarray Printing File Path dialog box and paste 
the file name (e.g. SpotBot3_Test_Print) copied from the previous window. 

• Users should also make sure the User Profile dialog box is checked as shown here. 
• Checking the Content Map dialog box generates a .txt file that can be used to generate a 

GAL file when used in conjunction with GAL File Creator v2.0.1. 
• Click Finish to complete the SPOCLE file generation process. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 

SPOCLE Gen v3.5.2 
SpotApp v3.6.0  November 30, 2010 

11 

Phone: 408-744-1331 
FAX: 408-744-1711 
Email: arrayit@arrayit.com 
Web: www.arrayit.com 

Arrayit Corporation (ARYC) 
524 East Weddell Drive 
Sunnyvale, CA 94089 
USA 

 

II.  SpotApp v3.6.0 
 
• In the second software step, users execute the newly-created SPOCLE Generator 

printing routine using SpotApp v3.6.0. 
• Make sure the COM cable and power supply are connected at the back of the SpotBot® 

3 Microarrayer instrument panel. 
• Connect the other end of the COM cable to the personal computer (PC) supplied with the 

instrument.  Make sure the COM cable thumb screws are tightened completely to ensure 
a proper connection. 

• The instrument power supply should be connected to a proper 110-volt or 220-volt 
power source. 

• The PC should be connected to the Internet via the Ethernet cable supplied with the 
instrument. 

• Double-click on the SpotApp v3.6.0 desktop icon (shown here as highlighted) to launch 
the SpotApp v3.6.0 software. 
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• If the SpotBot® 3 is properly connected to the computer, Internet and power supply, 
the SpotApp v3.6.0 window will appear as shown here. 

• Proper connectivity is shown as “Ready” next to Status at the bottom left corner of the 
menu. 

• SpotBot® 3 customer registration is required to operate the instrument. 
• The SpotApp main menu allows users to select SPOCLE printing files (File) and to 

perform instrument functions such as pin cleaning, pin loading and calibration (Tools). 
• SpotBot® 3 instruments arrive at the customer site pre-calibrated. Please do not 

attempt re-calibration without first consulting with Arrayit technical staff 
(arrayit@arrayit.com). 

• Click on File to select a printing routine created previously with SPOCLE Generator. 
• New users should select “Open SpoCLE File” under the File menu to print on glass 

substrate slides. 
• The File menu also offers “Open Well Plate Spocle File” as a menu option for printing 

onto 96-well glass plates, but this is an advanced user option. Please contact Arrayit 
technical assistance (arrayit@arrayit.com) for well plate printing. 
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• The Source Microplates (384-well) menu allows users to select the type of 384-well 
microplate containing the printing samples. 

• The SpotBot® 3 instrument arrives pre-calibrated to load samples from Arrayit 384-well 
microplates. 

• New users should select the default Arrayit 384-Well Microplate option as shown here, 
and use the Arrayit brand microplates provided with the instrument. 

• The Source Microplates menu allows users to Re-calibrate the current microplate or 
select a New microplate type. Please contact Arrayit technical support 
(arrayit@arrayit.com) for assistance with microplate calibration. 

• Click Select to advance to the next window. 
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• The Insert Microplate menu instructs users to insert the first 384-well microplate onto 
the deck of the SpotBot® 3 instrument. 

• The 384-well microplate should be inserted with well A1 positioned in the front left 
corner of the instrument adjacent to the microplate locator spring. 

• Make sure the microplate is seated flat against the instrument deck, with the locator 
spring properly positioned against the side of the microplate adjacent to well A1. 

• Make sure that the glass substrates are in their correct locations, and that the 
substrates on the printing deck are planar and free of obstructions. 

• The 14 glass substrate slides (1.0 x 25 x 76 mm) are held into place using the L-bracket 
substrate holder and substrate locator spring. 

• Improperly positioned microplates or glass substrate slides can cause permanent 
hardware damage and must be avoided under all circumstances. 

• Click Continue to advance to the next window. 
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• The Load Pin Set menu instructs users to load the correct type and number of pins into 
the SpotBot® 3 printhead. 

• New users should load four 946MP4 pins in a 2x2 configuration as shown here. 
• Wear nitrile gloves at all times when handling pins, as hand oils and other contaminants 

may cause pins to glide poorly in the printhead thereby reducing printing quality. 
• Ensure that the microplate, substrate slides and pins are all positioned properly. 
• Close all three instrument doors and click Continue to advance to the next window. 
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• The appearance of this menu indicates that SpotApp v3.6.0 has launched and is 
executing the SPOCLE printing routine. 

• The progress bar reports real-time command execution as a percent (%) of commands 
executed (0.2% shown here). 

• The SpotBot® 3 will continue to execute the SPOCLE printing routine until all of the 
commands have been completed. 

• The user may terminate printing at any time during the printing process by clicking on 
End in the dialog box. 

• The SpotBot® 3 will clean the pins and complete the printing process automatically. The 
printhead will end up in the “home” position at the end of the print run. 

• Users are encouraged to close the SpotApp v3.6.0 application at the end of each printing 
session to conserve energy. 

• Users must also turn off the megasonic wash station, peristaltic pump and air 
compressor once printing is complete. 

 

 
 


